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Today’s Agenda
Background and objectives

Model Development Review

Model Validation Datasets

Changing FHWA Guidance on Calibration

Calibration Process Review

Model Review Process
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Senate Bill (SB) 375 (Sustainable Community), SB 743 (CEQA Reform), 
and SB 391 (California Transportation Plan) require a more robust 
quantitative and analytic evaluation to describe the relative performance of 
transportation policies, strategies, and programs.

SB 1, now in force, created the Solutions for Congested Corridors Program. 
Caltrans will be collaborating with regional partners to identify and develop 
fixes for these corridors, which cannot be analyzed using static methods 
alone.

On-call traffic simulation training will enable Caltrans to meet the mandate 
of these bills by educating Caltrans staff about how to perform complex 
analyses of our facilities for critical planning, operations, and capital 
improvement projects using the latest generation of traffic analysis tools.
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Project Background and Objectives



Webinar Four-part Series
Webinar 1 - Transportation Analysis and Simulation Overview – Delivered in 
January 2018

Webinar 2 – Scoping a Simulation Project – Delivered in June 2018

Webinar 3 - How to Develop, Calibrate & Review Models – Today

Webinar 4 - How to Interpret and Communicate Model Results and How to 
Produce Output for Environmental Studies from Simulation Models –
Documentation of calibration assumptions and results; documentation of 
overall analysis results; with and without project; tables, charts, graphics 
and maps summaries of performance measures.  Key output from 
simulation models, key needs for environmental studies (volumes, delays, 
speeds, queueing, travel time, VMT, etc.), how to use and interpret 
simulation model output for environmental studies.  
Delivery date tentative January 2019.
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Macro, Meso and Micro 
Simulation Modeling

Macro - Long range 
traffic forecasts, 
regional patterns 
and mode shift

» Usually Demand 
Modeling

» Rarely Simulation

Meso - Traveler 
information, HOT lanes, 
congestion pricing, 
regional diversion

Micro - Detailed analysis 
of physical 
improvements and traffic 
control strategies, 
congested conditions



Analysis Resolutions



What is Calibration?
Calibration is the adjustment of model parameters to 
improve the model’s ability to reproduce time-dynamic 
system performance observed under specific operational 
conditions. 



What is Validation?
Process where the analyst checks the overall model-
predicted traffic performance for a street/road system 
against field measurements of traffic performance, such 
as traffic volumes, travel times, average speeds, and 
average delays.



MODEL DEVELOPMENT
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Traffic Analysis Tools: Volume 
III Microsimulation

Microsimulation Model Development 
Process 
» From forthcoming update version



Review of Basic Network Elements
Geometry
» Network connectivity
» Section/Link parameters
» Turn/Connector parameters

– Reduced speeds
– U-turn prohibitions



Review of Basic Network Elements
Signal Controls
» Physical movements coded for each phase
» Proper coding of timing and phase settings
» Fixed vs Actuation
» Actuation settings properly coded?
» Coordination?

Stop Controls
» Driver reactions



Review of Basic Network Elements
Demands
» Zones / Centroids / Parking Lots
» Review OD preparation and adjustment process
» Traffic Demands

– Static Routes
– OD Matrices
– Vehicle Types
– Scaling Factors

Warm-up time

Cool-down time



Review of Basic Network Elements
ITS Elements

Existing Traffic Management Strategies

Transit



Pre-Calibration Error Checking
Test via diagnostic runs
» Low volume simulations

Are vehicle movements realistic?

Are signals functioning correctly?

Are vehicles routed logically?
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MODEL VALIDATION DATASETS
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Traditional Types of Data

Physical 
Geometry

• Rectified aerial 
photography

• Base GIS 
mapping files

Traffic Control

• Signs
• Signal control 

timing plans
• Ramp Meter 

Controls

Travel Demand

• Traffic counts
• Vehicle 

classification 
counts

• Transit 
Schedules

Operational 
Data

• Speeds
• Travel times
• Congestion
• Queuing 

measurements
• Other field 

observations



Using PeMS Data – Downloading 
Data

PeMS Data Clearinghouse provides a single access 
point for downloading PeMS data sets.

Flow and Speed
» 5-minute data
» AM, PM peak period or 24 hours
» Week or Weekday (Tuesday, 

Wednesday, Thursday), no holidays
» Month or Year

Health of Detectors 
» Use flow and speed, only if it 

observed data is good.



PeMS Detector Health

http://pems.dot.ca.gov/?dnode=search&content=cnt_search&view=p#33.87487,-118.08187,15



Using PeMS Data – Analyzing Data
Once data is selected for the region and time of interest, 
heat maps can be developed to visualize speeds, 
congestion, flows, and quality of data for a specific time 
period.



Speeds and Reliability Index 
Comparison

WB SR-91 corridor 
speed profile during 
PM peak period 

Detector health along 
WB SR-91 corridor 
during PM peak hour
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Emerging Types of Data – Connected 
Devices and Location Based Services

Operational 
Data

• Gov’t & 3rd

Party 
Databases

OD Data

• Infrequent 
pings

• Where do 
devices 
rest?

Route 
Choices

• Frequent 
pings

• What 
routes do 
devices 
travel?



Transportation Databases - Federal
Database Description Extents

FHWA Highway 
Performance Monitoring
System (HPMS)

Data on the extent, condition, performance, use and 
operating characteristics of the nation's highways. 
Also captures characteristics of some arterial and 
collector functional systems.

Nationwide

FHWA National Bridge 
Inventory (NBI)

Condition data on more than 600,000 bridges located 
on Interstate Highways, U.S. highways, State and 
county roads, and publicly-accessible bridges on 
Federal lands.

Nationwide

FHWA National 
Household Travel Survey 
(NHTS) Add-On 

Supplementary survey data purchased by State DOTs,
MPOs, and COGs for their local areas.

Survey Partners 
(also known as 
Add-Ons) exist 
nationwide

U.S. Department of 
Homeland Security 
Weigh-in-Motion (WIM) 
Stations

WIM devices record axle weights and gross vehicle 
weights as vehicles drive over a measurement site.

Nationwide

National Performance
Management Research 
Data Set (NPMRDS)

Historical traffic information using anonymous, real-
time aggregated GPS probe data from a wide array of 
commercial vehicle fleets, connected cars and mobile 
apps.

Nationwide (for
National Highway 
System)



Transportation Databases
State and Regional

Database Description Extents

Caltrans Performance 
Measurement System 
(PeMS)

Real-time and historical traffic data collected 
from nearly 40,000 individual freeway 
detectors.

All major
metropolitan 
areas in 
California

Location-Based 
Services Data 

Set of mobile phone location based services 
data used to glean insights into linked trips and 
tours, robust demographics, and travel 
purpose.

Southern 
California

Arterial Performance 
Measurement Tool 
(APMT)

Establishes baseline performance conditions 
for selected subregional arterial corridors, such 
as travel demand, productivity, mobility and 
reliability.

Specific to Los
Angeles
County

Caltrans Automated
Pavement Condition 
Survey (APCS)

Condition data collected at highway speeds 
using specialized vehicles with inertial profilers, 
transverse laser system, and high resolution 
cameras for all lanes of the entire State 
Highway for compliance reporting for MAP-21.

Within the 
State of 
California



Transportation Databases
State and Regional

Database Description Extents

Statewide Integrated 
Traffic Records 
System (SWITRS)

Data gathered from collision scenes by 
California Highway Patrol staff and members of 
its Allied Agencies.

Within the 
State of 
California

California Vehicle 
Inventory and Use 
Survey (CA-VIUS)

State-level vehicle inventory survey that has 
collected information about commercial vehicle 
operations from establishments that operate 
trucks on California’s roadways.

Mostly geared 
towards trucks
that operate in 
California

Caltrans Traffic 
Counts

Individual Caltrans Districts have calculated the 
volumes hourly, daily, and monthly to derive an 
annual average daily traffic count.

Within the 
State of 
California

Truck Activity 
Monitoring System 
(TAMS) 

Uses inductive loop signature technology to 
obtain high resolution truck data at Inductive 
Loop Detector sites and Weigh-in-Motion sites.

Various 
locations
across 
California



Transportation Databases – Private 
Sector & Other

Database Description Extents

INRIX, HERE, Waze Real-time, historical and predictive traffic 
information using anonymous, real-time 
aggregated GPS probe data from a wide array 
of commercial vehicle fleets, connected cars 
and mobile apps.

Nationwide

Streetlight Data Collection of anonymized location records 
created by mobile phones, GPS devices, 
connected cars, commercial trucks, fitness 
trackers, etc. 

Nationwide

Airsage Collection of real-time mobile signals, GPS and 
other location data to produce and process 
billions of anonymous data points every day.

Nationwide

American 
Transportation 
Research Institute 
(ATRI)

Real-time anonymized freight truck GPS data 
(e.g., periodic time, location, speed) sourced 
through unique industry partnerships.

Nationwide



CHANGING FHWA GUIDANCE ON 
CALIBRATION
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Current References



Calibration Criteria:
Current Microsim State of the Practice

Traffic Analysis 
Tools Volume III 
(2004)
» “FHWA criteria”
» (Actually 

Wisconsin)



Other State References
Other State References
» Oregon DOT’s Protocol for VISSIM Simulation
» Washington DOT’s Protocol for VISSIM Simulation
» Maryland DOT’s VISSIM Modeling Guide
» Virginia DOT’s Traffic Operations and Safety Analysis Manual & 

VISSIM User Guide, 
» Wisconsin DOT’s Traffic Engineering, Operations & Safety 

Manual - Chapter 16 Section 20 Microscopic Simulation Traffic 
Analysis

» Florida DOT’s Traffic Analysis Handbook
» Iowa DOT’s Microsimulation Guidance
» Arkansas DOT’s Guidelines for the Use of Microsimulation on 

AHTD Projects
» Delaware Valley Regional Planning Commission’s VISSIM 

Standards Project
» Louisiana DOT’s Microsimulation Modeling Policy 
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Other Valuable References
International References
» MULTITUDE (2014)

Other FHWA Traffic Analysis Toolbox 
Reports:
https://ops.fhwa.dot.gov/trafficanalysistools/index.htm

» Volume XIII: ICM AMS Guide
» Volume XIV: Guidebook on DTA Modeling
» And others
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Key Concerns with Previous FHWA 
Guidance

Fully Integrate Time-Dynamic Representation of 
Congestion

Require Better Representation of Recurrent and Non-
Recurrent Conditions

Remove Subjective Calibration Criteria

Emphasize Accurate Bottleneck Modeling 



Forthcoming Volume III Update
New Volume III Update Report is completed, but not yet 
published

Workshops introducing this new methodology are being 
conducted by FHWA

Publication date still TBD
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New FHWA Guidance

Source: FHWA Volume III Update Workshop



Real Systems Have Good Days & Bad Days
2012 Southbound AM Peak Travel Times, I-405 Corridor (WA)

Source: FHWA & Noblis “TAT Volume III Guidelines for Microsimulation” presentation 



Even An Average Day Captures Only 
a Fraction of System Dynamics

Source: FHWA & Noblis “TAT Volume III Guidelines for Microsimulation” presentation 

Worst Day

Best Day

Average Day



Use Cluster Analysis to Identify
Distinct, Dissimilar Operational Conditions

Horrid Days

Relatively Good Days

Not-So-Good Days

Source: FHWA & Noblis “TAT Volume III Guidelines for Microsimulation” presentation 



Simulations Are Calibrated to Lie 
Within the Statistical Envelope

We Perform Statistical Testing to Determine if the Simulated Day 
Falls in the Envelope Under Many Trials

Simulated Horrid Day

Simulated Relatively Good Day

Simulated Not-So-Good Day

Source: FHWA & Noblis “TAT Volume III Guidelines for Microsimulation” presentation 



Develop Clusters of Conditions

Source: FHWA Volume III Update Workshop



Select Representative Days

Source: FHWA Volume III Update Workshop



Example: 
San Diego ICM AMS Scenarios

Summary of Best Matching Incident Results



Experimental Design for Analysis of 
Different Operational Conditions
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Operational Condition Dartboard
Scenario Frequency

Highest 
Priority

• Scenarios with greatest 
frequency and impact

Lower 
Priority

• Scenarios with low 
likelihood but major impact

• Scenarios with frequent 
occurrence but limited 
impact

Lowest 
Priority

• Scenarios with low 
frequency and low impacts

Source: Federal Highway Administration.



CALIBRATION PROCESS REVIEW
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Overall Calibration Process
Establish calibration objectives.

Identify the performance measures and critical locations against which 
the models will be calibrated.

Determine the statistical methodology to be used to compare modeled 
results to the field data.

Determine the strategy for model calibration and identify parameters 
that are the focus of adjustments.

Assemble field data previously collected for comparison to model 
outputs

Conduct model calibration runs following the strategy and conduct 
statistical checks.

Validation: Test or compare the calibrated model with 
a data set not used for calibration



Model Calibration Methods
Traffic Network Calibration

Route Choice Calibration

Demand Calibration

Ideally in that order

Reality is an iterative process



Network Calibration Parameters
Network Representation
» Accurately represented

– Posted speeds, lane channelization, grades, visibility, 
speeds on curves, etc.

Driver Behavior
» Car following parameters, lane changing parameters, 

desired speed distributions, etc. 

Controls
» Driver reaction to signals / stop controls
» Gap acceptance model parameters



Route Choice Parameters
Cost functions

User costs

Vehicle type restrictions

DTA use and settings

Value of time / Willingness to pay



Demand Calibration
Initial OD source / estimation

OD Matrix Estimation (ODME) process (if used)
» Static
» Dynamic

Trip Length Frequencies

Temporal profiles



Calibration Parameter Checks
Use of heavy local adjustments is not good calibration
» Some are evitable

Global and/or roadtype adjustment are preferred
» Or rules based application of parameter changes

Adjusting too many parameters is not good practice
» Adjust key parameters the modeler has confidence in

Avoid overfitting of model to field data

Are enough random seed runs being performed?
» Statistical significance of results



MODEL REVIEW PROCESS
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Review of Calibration Results
Simulation Runs
» Replicate the existing calibration results
» Review / identify problematic areas

– Areas of poor fit
– Low speeds
– High densities
– Low flow rate
– Prolonged queuing
– Unintuitive routes



Example Speed Contour Diagram



Speed & Bottleneck Validation



Volume Validation Scatterplot: 
Local Micro Example

R² = 0.9966
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Criteria
Counts 

Satisfying 
Criteria

Percentage 
Satisfying 

Criteria
Target

GEH < 2 67 77.9% n/a
GEH < 5 86 100% > 85%
GEH < 10 86 100% n/a

Criteria
Counts 

Satisfying 
Criteria

Percentage 
Satisfying 

Criteria
Target

Within 15%, 
for 700 veh/h < Flow < 2700 veh/h 41 100% > 85%

Within 100 veh/h, 
for Flow < 700 veh/h 43 100% > 85%

Within 400 veh/h, 
for Flow > 2700 veh/h 2 100% > 85%



Volume Validation Scatterplot: 
Subregional Micro Example
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Counts Meeting 
Criteria

Percentage of 
Counts

GEH < 2 22 55%
GEH < 5 34 85%
GEH < 8 35 88%
GEH < 10 38 95%

Criteria and Measures Counts Meeting 
Criteria

Percentage of 
Counts

>85% within 100 veh/h, for 
Flow < 700 veh/h (>85%) 3 60%

>85% within 15%, 
for 700 veh/h < Flow < 2700 veh/h 18 86%

>85% within 400 veh/h, 
for Flow > 2700 veh/h 13 93%



Volume Validation Scatterplot: 
Regional Meso Example

AM6-9 Period Flow - Entire DTA AM6-7 Hour Flow - Entire DTA
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Volume Validation Regional Meso Example
Total Error and RSME % 

AM Peak Period - All Counts RSME% by Hour - All Counts

Fac# Facility Counts Sum Count Sum Model
Average 
Count

Average 
Model

Avg 
Error Facility

6-7 AM 
Hour

7-8 AM 
Hour

8-9 AM 
Hour

3 Hour 
AM Peak

1 Freeways 148 1,235,701    1,223,770   8349 8269 -1% Freeways 0.16 0.15 0.15 0.12
2 Expressways 26 112,550        104,913       4329 4035 -7% Expressways 0.35 0.20 0.27 0.22
3 Princ.Art 130 203,504        191,701       1565 1475 -6% Princ.Art 0.65 0.41 0.41 0.42
5 Minor Art. 158 120,446        114,681       762 726 -5% Minor Art. 1.01 0.86 0.83 0.83
7 Collector 98 57,701          50,216         589 512 -13% Collector 0.77 0.77 0.83 0.72
8 Ramp 273 220,404        260,226       807 953 18% Ramp 0.82 0.57 0.60 0.59
9 Fwy-Fwy Ramp 63 105,742        117,568       1678 1866 11% Fwy-Fwy Ramp 0.61 0.50 0.55 0.52
>0 All Roads 896 2,056,048    2,063,075   2295 2303 0% All Roads 0.38 0.33 0.34 0.30

AM Peak Period - Focus Area Counts RSME% by Hour - Focus Area Counts

Fac# Facility Counts Sum Count Sum Model
Average 
Count

Average 
Model

Avg 
Error Facility

6-7 AM 
Hour

7-8 AM 
Hour

8-9 AM 
Hour

3 Hour 
AM Peak

1 Freeways 31 227,697        229,431       7345 7401 1% Freeways 0.16 0.19 0.18 0.16
2 Expressways 12 49,723          48,087         4144 4007 -3% Expressways 0.40 0.17 0.31 0.23
3 Princ.Art 17 18,822          12,563         1107 739 -33% Princ.Art 0.66 0.48 0.56 0.51
5 Minor Art. 30 25,709          19,232         857 641 -25% Minor Art. 0.87 0.81 0.78 0.76
7 Collector 31 18,873          12,116         609 391 -36% Collector 0.89 0.73 0.72 0.69
8 Ramp 64 57,590          58,866         900 920 2% Ramp 0.85 0.56 0.60 0.57
9 Fwy-Fwy Ramp 20 43,868          49,873         2193 2494 14% Fwy-Fwy Ramp 0.37 0.35 0.41 0.34
>0 All Roads 205 442,281        430,168       2157 2098 -3% All Roads 0.40 0.35 0.38 0.33

            

  
           

 
               
                   

                     
                   
                   

                     
                 



New FHWA Guidance:
Time Variant Variations



New FHWA Guidance:
Four Criteria

Criterion I: 

Criterion II:
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New FHWA Guidance:
Four Criteria

Criterion III:
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New FHWA Guidance:
Four Criteria

Criterion IV:
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Review of Calibration Results
Test Simulation Runs
» Replicate the existing calibration results
» Review / identify problematic areas

– Areas of poor fit
– Low speeds
– High densities
– Low flow rate
– Prolonged queuing
– Unintuitive routes



Additional Validations
Ideally validate to a second set of data
» A similar representative day

Model stability tests
» Test different random seeds
» ‘Local link removal’ test

Model reasonableness tests
» Does the model respond in a logical way to a change?



ADDITIONAL 
QUESTIONS?
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